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Introduction
SampleEd allows you to create, edit and play back sound samples.

Main features are:

• Load and save samples in a variety of different formats
• Disk based editing not limited by available memory
• Apply a variety of affects to samples including fades, echoes and loops
• Supports the LADSPA plugin protocol for effects
• Uses Digital Renderer to play back samples
• Samples can have up to 32 channels

LADSPA
LADSPA stands for Linux Audio developer's Simple Plugin API and provides a mechanism to add new effects or tools to
SampleEd. These can of course be used by other applications that support the LADSPA protocol. More details can be found at
http://www.ladspa.org.

Requirements
SampleEd should run on any RISC OS 3+ machine with 4MB of memory. It does require the Toolbox modules so this might push
requirements up somewhat. Any processor should do although obviously an ARM2 will be very slow and a StrongARM or above is
best.
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Getting started

Loading SampleEd
Before SampleEd is loaded the !LADSPA application should have been seen by the filer. This is where any effects plugins are
stored. The best place for !LADSPA is in Resources, where the installation notes will have suggested it is placed.

Note that it is not vital for !LADSPA to be installed, but if it is not then SampleEd will not be able to make use of any third party
plugins.

SampleEd is loaded by double clicking on the SampleEd icon in the filer display: 

Once loaded the SampleEd icon will appear on the iconbar in the standard way.
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Creating a new sample
Clicking Select on the icon bar icon will cause a small window to appear. This is the New sample window. It allows you to specify
details about the new sample you want to create:

Sample rate
This is the frequency of the sample. The number specified is in Hertz. In the example shown 44100 Hertz is 44.1 KHz, the same
quality as a Compact Disc. The higher the frequency the better quality the sound will be but the more memory it will use.

Sample time
The Sample time is the length of time in seconds that the sample will last for.

Channels
The number of channels that the sample will have. This can be any number from 1 to 32 but the most common settings will be
1 for mono or 2 for stereo. The size of the sample will increase in proportion to the number of channels chosen. 
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Memory
This field shows the amount of memory the sample will use, or the size of the file if it is saved as a Wave file. SampleEd stores
all samples internally as 16 bit samples. The memory required is calculated as follows:

Sample rate x sample time x channels x 2

In the example shown this becomes:

44100 x 1.0 x 1 x 2 = 88200 or 86K

The final 2 is needed because each 16 bit sample uses two bytes.

Clicking the Create button will create the new sample and display the sample window.
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The Sample window
The Sample window displays a graphical representation of the sample. When a new sample is created this window is blank:
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This window has a number of controls along the top bar.

Play
Clicking this will play the sample once.

Play selected
Clicking this will play any area of the sample that is highlighted. If no area is highlighted then the whole sample will be played.
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Play unselected
If you have a highlighted area of the sample, this will play a short period before and after the highlighted area, but not the
highlighted area itself. This is use if you are going to remove an area of the sample and want to hear what it will sound like
afterwards.

Pause
If this is clicked whilst a sample is playing the playback will pause. Clicking Pause again will resume playback.

Stop
Clicking this while a sample is playing will stop the playback.

Volume
This slider controls the volume of the sample being played back.

Selected/Clear
If any part of the sample is highlighted then clicking this button will clear the selection. If no part of the sample is highlighted then
clicking this button will select all of the sample.

The remaining fields are informational only.

Sample rate
The sample rate of the sample measured in Hertz.

Duration
The length of the sample in minutes and seconds.
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There are also a number of controls down the left hand side of the window. These controls are repeated once for each channel.

Channel volume
This slider sets the volume level of the channel relative to the main sample volume.

Channel stereo
This slider sets the stereo position of the channel.

There is one other control that applies to the whole toolbar:

Hide toolbar
Clicking this will hide the toolbar, except for this button.Clicking whilst hidden will show the toolbar.
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Highlighting an area of a sample
A number of operations require an area of the sample to be highlighted. This is achieved by dragging the mouse pointer over
the area to be selected:

This will then highlight the selected area:
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The start or end of the area can be changed by clicking with Adjust:

Click here with Adjust Highlighted area is extended

As already mentioned, samples can have more than one channel. It is possible to highlight different areas of each channel or
the same area of all channels. To highlight a different area of a different channel the pointer must be dragged over the channel
itself. To highlight all of the channels the same the pointer must be dragged in the gap in between each channel.
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The sample marker
Clicking in the above areas rather than dragging will set a marker which is shown as a blue bar. This maker is used during pasting
operations to specify where a block of sample data will be inserted.

Other ways of highlighting sample data
The Edit section detailed later covers a number of menu items that can also be used to highlight portions of a sample in different
ways.
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Loading a sample
To load an existing sample the file is dragged to the SampleEd icon on the icon bar. For a list of supported sample formats see
Appendix A.

The Sample window is then displayed showing the sample. Note that depending on the length and format of the file being loaded
this may take some time, even on the fastest computers.

For a sample to be loaded in this way it must have a file type other than Data. If the sample has a file type of Data then the Import
window will be displayed:

Importing unknown sample formats
The Import window is displayed if an unknown sample file is dragged to SampleEd:
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This allows the format for the sample being loaded to be specified in the event that SampleEd cannot identify the file from the
contents. This also allows raw sample data to be imported. The following settings are available:

Sample rate
This is the frequency of the sample. The number specified is in Hertz. 44100 Hertz is the same quality as a Compact Disc.

Channels
The number of channels that the sample will have. This can be any number from 1 to 32 but the most common settings will be
1 for mono or 2 for stereo.

Page 12



Format
This is encoding that SampleEd will assume is applied to the imported file. Available formats are as follows:

Unsigned 8 bit PCM
Signed 8 bit PCM
Signed 16 bit PCM
Signed 24 bit PCM
Signed 32 bit PCM
32 bit float
64 bit float
U-Law
A-Law
GSM 6.10
12 bit DWVW
16 bit DWVW
24 bit DWVW
VOX ADPCM

Force use of settings
SampleEd will attempt to determine the format of the sample even if this window is displayed. Switching on this option will tell
SampleEd to use the specified settings when loading the sample regardless of whether the sample format can be identified.

Clicking the OK button will load the sample, Cancel will close the window without loading the sample.
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Importing a sample
SampleEd offers the ability to import one sample file into another. This gives the ability amongst other thins to join together
separate samples, or to merge two mono samples into one stereo sample.

The way in which the sample data is merged together is dependent on the Paste options settings, see later for a full explanation.
The imported sample can be slotted into the current sample or can overwrite a section of it using these settings.The example
below shows how to turn two mono samples into one stereo sample.

For this example we assume that there are two mono samples available and that the default Paste options of Insert are being
used.

Creating a new blank stereo sample gives us the following window:

We will now highlight all of channel one. The easiest way of doing this is to open the main menu over channel one and choose
Select channel from the Edit menu.
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        Choosing Select channel...        ...highlights the channel the menu is over

Dragging the first file to this channel will now import the sample. It is important to drag the file to the channel where the data is
to be imported to and not just to the Sample window.

The sample is imported with the highlighted section of the first channel being replaced with the new sample data, and the sample
as a whole being made bigger to accommodate all of the new data. If none of the channel had been highlighted the new data
would have been imported at the beginning of the channel and the existing channel data would have been added to the end.
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Repeating the same process for the second channel gives us the new stereo sample:

This time the second channel was highlighted and the second sample file dragged to this channel.

If the file being imported has more than one channel then the first channel will be imported to the channel the file is dragged to
in the Sample window and the next to the next channel in the Sample window until all channels have been imported. If there
are any further channels to be imported after the last channel in the Sample window has been used then the import will wrap to
the first channel in the Sample window.

When importing a file like this each channel is handled independently of the others so it is important to highlight the required
areas of all the channels before the file is imported.
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Applying effects to samples
Moving the pointer over the Effect entry on the main menu displays the Effect menu:

This gives access to a number of effects that can be applied to a sample. In order for any effects to be applied an area of the
sample must be highlighted.

Reverse
Choosing this will reverse the highlighted area of the sample so when it is played it will play backwards.
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Amplify
Choosing this will display the Amplify window:

Amplification changes the volume of the sample. Too much amplification will cause the sample to sound distorted when it is
played.

Percentage
The percentage amplification to apply to the sample.

Maximum
If this is selected SampleEd will attempt to calculation the maximum amplification it can apply to a sample without it becoming
distorted.

Clicking Amplify will apply the amplification factor to the sample, Cancel will close the window without making and changed.

Centre
This item tries to balance the sample so it falls evenly over the central red line in the sample window.
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Fade
This will display the Fade window:

This window allows the sample to be gradually faded in or out. There are six preset fades in the corner of the window and
clicking any of these will change the main display.
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Alternatively, the line in the main display can be dragged into any shape:

Clicking Apply will fade the sample according to the specified curve, Cancel will close the window without making any changes.
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Echo
Choosing this will display the Echo window:

This allows an echo to be applied to the sample.

Delay
The delay in seconds before the echo sounds. This determines how cavernous the echo sounds.

Strength
The strength of the echo compared to the original sample. This will determine how load the echo is.

Reducing to
The strength or loudness that the echo should drop to by the time it finishes compared with the original sample.

Pre echo
Normally an echo sounds after the original sound. Selecting this will cause the echo to start before the original sound.
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Clicking Echo will apply the echo, Cancel will close the window without making any changes.

When the echo is applied it may affect the size of the sample to ensure that the full echo is heard.

Loop
Choosing this item will apply a loop to the highlighted area of the sample. This means that when the sample is played back the
looped area of the sample will play several times before the sample finishes playing. Note that note all output formats support
looped samples so this information may be lost then the sample is saved.
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Equation
The equation window allows a mathematical equation to be written to specify the sample waveform:

Any normal mathematical symbols and functions can be used including:

( ) + - * / SIN COS TAN

The example shown will produce a tone at middle C.

Appendix B shows a full list of the functions and constants available.
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Preview
Clicking this button will display a preview of the calculated waveform in the window.

Clicking Apply will store the calculated equation in the sample, Cancel will close
the window without making any changes.

This window has playback controls similar to the main sample window. This
allows the previewed equation to be heard before it is applied to the main
sample.
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Harmonics
This window allows the waveform to be 'drawn' using fifteen different sliders, each representing a different frequency.

Fundamental frequency
This is the frequency applied by dragging slider 1. In the example shown the frequency is equivalent to middle C.

Sliders
Each slider represents a different frequency, with slider 1 being the fundamental frequency, slider 2 the fundamental frequency
times 2,slider 3 the fundamental frequency times 3, up to slider 15.

The sliders have represent 0% to 100% of the amplitude of the selected frequency.

When the sliders are dragged the waveform which will be updated in real time.

Reset
Clicking this button will zero all the sliders.

Clicking Apply will store the harmonic in the sample, Cancel will close the window without making any changes.

This window has playback controls similar to the main sample window. This allows the waveform to be heard before it is applied to
the main sample.
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Plugins
SampleEd supports the LADSPA plugin mechanism. This was originally written for Linux but supporting it in SampleEd gives
access to a wide range of different filters and effects. The exact effects available will depend on what is installed on your
system.

This menu item will display a list of the different plugins that are installed, each of these have a menu listing the effects
supplied by that plugin.

Choosing an effect will display the Plugin window. The contents of this window will vary greatly depending on the plugin
selected. The following example tries to explain all common field types that may be displayed:
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Name
The name of the plugin.

Maker
The author or company or wrote the plugin.

Copyright
Any copyright or licensing notices.

Inputs
Plugins can have 0 or more inputs. The number will vary depending on what the plugin does. In this example we have a single
input which defaults to the first channel of the sample to which the plugin will be applied. This is shown as follows in the window:

The In label shows this is an input port. The field shows that the input data will be coming from channel 0 of the sample
do_not_go/aif. The microphone icon allows us to change where the input is coming from. This can be dragged to any sample
windows, including the Harmonics and Equation windows. The field will change to show where the input is coming from.

The Wrap option button is provided in case the input sample data selected is not of a sufficient duration to fill the corresponding
output area. If this is selected then the input sample data will be repeated as many times as necessary to fill the output area. If
not, once the input sample data has been exhausted any further input data required will be treated as silence.

Option buttons
Some plugins require simple on/off type settings. These settings are shown as an option button.
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Sliders
Some inputs require a numerical value. These are shown as slider bars with a numerical field next to them. The values that can be
entered into these fields will be limited by the plugin.

Outputs
In the same way we have inputs, we also have outputs. Normally 1 or more. The first output will default to channel 0 of the sample
to which the plugin is being applied.

As with inputs, the output data can be redirected to another channel or another sample.

The area where the output data will be placed must be highlighted in the target sample.

Clicking Apply will run the plugin, Cancel will close the window without making any changes.
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Editing a sample
Moving the pointer over the Edit item on the main menu shows the Edit menu:

This allows areas of a sample to be copied, moved or deleted. As mentioned in the section on the Sample window, areas of a
sample can be highlighted. The top group of items on this menu will not be available if any area of sample is not highlighted.

Cut
This will remove the highlighted area of the sample. The sample that falls directly after the highlighted are will be moved to replace
the highlighted are and silence will be added to the end of the sample to fill the gap left. The sample data that has been removed
will be placed into the clipboard so it may be pasted back elsewhere.
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Copy
This will copy the highlighted area of the sample into the clipboard so it may be pasted back elsewhere. The original sample will be
unaffected.

Paste
If an area of sample has been cut or copied to the clipboard it can be pasted back elsewhere using this item. The area where
the sample is to be pasted must be highlighted or marked before first. The exact way in which the data is pasted depends on
the Paste options cover later.

Clicking this was cause the mouse pointer to turn to cross hairs. Click on the channel where the sample data should be pasted.
If the clipboard contains multiple channels then this will be the first channel to be pasted.

Delete
This will delete the highlighted area of the sample. This is the same as the Cut item but does not place the highlighted area onto
the clipboard. Note that the overall size of the sample will not be affected. If you wish to reduce the size of the sample then use
the Adjust size window covered below.

Blank
This will silence the highlighted area of the sample.

Crop
Similar to Blank, this will silence an area of the sample. However, instead of silencing the highlighted area it will silence everything
except the highlighted area.

Select all
This will highlight all of the sample.
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Clear
Unhighlights any highlighted areas of the sample.

Select channel
This is the same as Select all except that it will only highlight all of the channel that is under the menu when it is opened. 

Select channel to end
Choosing this over a channel that has a highlighted area will cause the channel to be highlighted from the start of the currently
highlighted area to the end of the sample.

Select channel to start
Choosing this over a channel that has a highlighted area will cause the channel to be highlighted from the start of the sample
to the end of the currently highlighted area.

Clear channel
This will unhighlight any section of the channel the menu was opened over.

Select loop
Highlights the area of the sample that is currently marked as being looped. If no area of the sample is looped this item will not
be available. This allows the looped area of the sample to be easily amended without having to reselect it by hand.

Select loop channel
Similar to the above item but only applies to the channel the menu was opened over.
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Adjust size
The number of channels, sample rate and duration of a sample are set when it is created. Using the Adjust size window these
details can be changed for an existing sample:

The meanings of the fields are the same as the New sample window:

Sample rate
This is the frequency of the sample. The number specified is in Hertz. In the example shown 41666 Hertz is 41.6 KHz, the same
quality as a Compact Disc. The higher the frequency the better quality the sound will be but the more memory it will use.

Resample
If this is switched off then when the sample rate is changed the pitch at which the sample is played back will be changed.
Increasing the sample rate will make the sample sound higher pitched and decreasing the sample rate will make it sound lower
pitched.

Switching this on will counter this affect and make the pitch of the sample sound the sample.
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Sample time
The Sample time is the length of time in seconds that the sample will last for.

Channels
The number of channels that the sample will have. This can be any number from 1 to 32 but the most common settings will be
1 for mono or 2 for stereo. The size of the sample will increase in proportion to the number of channels chosen.

Memory
This field shows the amount of memory the sample will use, or the size of the file if it is saved as a Wave file. SampleEd stores
all samples internally as 16 bit samples. The memory required is calculated as follows:

Sample rate x sample time x channels x 2

In the example shown this becomes:

11025 x 3.61 x 4 x 2 = 318402 or 311K

The final 2 is needed because each 16 bit sample uses two bytes.

Clicking the Adjust button will change the sample, Cancel will close the window without making any changes.
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Paste options
The Paste options window controls the way in which the contents of the clipboard are pasted into the target sample:

The way in which this setting affects the paste operation varies slightly according to whether the data is being pasted at the
sample marker or over a highlighted area.

Overwrite
When pasting at the sample marker this will cause any data after the marker to be overwritten by the pasted data.

Pasting over a highlighted block will replace the highlighted block and shift the remaining sample to make room if the data being
pasted is bigger than the highlighted block.

Insert
When pasting at the sample marker this will cause any data after the marker to be shifted to make room for the pasted data.

Pasting over a highlighted block will replace the highlighted block and shift the remaining sample to make room if the data being
pasted is bigger than the highlighted block.
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Mix by averaging
When pasting at the sample marker this will cause any data after the marker to be merged with the pasted data by averaging
the two samples together.
Pasting over a highlighted block will merge the data contained in highlighted block with the data being pasted by averaging the
two samples. Data after the highlighted block will be shifted to make room if the data being pasted is bigger.

Mix by adding
When pasting at the sample marker this will cause any data after the marker to be merged with the pasted data by adding the
two samples together.

Pasting over a highlighted block will merge the data contained in highlighted block with the data being pasted by adding the two
samples. Data after the highlighted block will be shifted to make room if the data being pasted is bigger.

Wrap channels when pasting
Sometimes it is useful to copy data from one channel in a sample and paste it back to more than one at the same time. Usually
when pasting the contents of the clipboard SampleEd will only paste to as many target channels in the sample as exist on the
clipboard. Setting this option causes the clipboard contents to wrap when all channels have been pasted so that all channels in
the target sample will have data pasted to them.

Clicking OK will accept the setting, Cancel will close the window without making any changes.
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Choices
The icon bar menu allows access to a Choices window which allows the following choices to be set:

Cache
As has been mentioned elsewhere, SampleEd does not restrict the size of the samples that it can edit to the amount of available
memory. Instead a fixed amount of memory is used into which the sample is loaded in blocks when being processed. This section
controls the amount of memory allocated as that fixed block. This is called the sample cache.

Percentage
This field specifies how much memory to allocate according to the size of the sample. For example, if this field is set to 20%
and a 100k sample is loaded then 20k will be allocated as the cache memory, subject to the limits of the following two fields.
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Minimum
This is the minimum amount of memory that will be allocated as cache, regardless of the size of the sample. A sensible minimum
is 128k.

Maximum
The maximum amount of memory that will be allocated as cache. This will depend on how much memory is in your computer
but anything from 1MB to 10MB is sensible.

It should be remembered that this cache is allocated on a per sample basis, not shared between all currently loaded samples.

Paste options
The Paste options section specifies the default way in which the contents of the clipboard are pasted into the target sample.

The way in which this setting affects the paste operation varies slightly according to whether the data is being pasted at the
sample marker or over a highlighted area.

Overwrite
When pasting at the sample marker this will cause any data after the marker to be overwritten by the pasted data.

Pasting over a highlighted block will replace the highlighted block and shift the remaining sample to make room if the data being
pasted is bigger than the highlighted block.

Insert
When pasting at the sample marker this will cause any data after the marker to be shifted to make room for the pasted data.

Pasting over a highlighted block will replace the highlighted block and shift the remaining sample to make room if the data being
pasted is bigger than the highlighted block.
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Mix by averaging
When pasting at the sample marker this will cause any data after the marker to be merged with the pasted data by averaging
the two samples together.

Pasting over a highlighted block will merge the data contained in highlighted block with the data being pasted by averaging the
two samples. Data after the highlighted block will be shifted to make room if the data being pasted is bigger.

Mix by adding
When pasting at the sample marker this will cause any data after the marker to be merged with the pasted data by adding the
two samples together.

Pasting over a highlighted block will merge the data contained in highlighted block with the data being pasted by adding the two
samples. Data after the highlighted block will be shifted to make room if the data being pasted is bigger.

Wrap channels when pasting
Sometimes it is useful to copy data from one channel in a sample and paste it back to more than one at the same time. Usually
when pasting the contents of the clipboard SampleEd will only paste to as many target channels in the sample as exist on the
clipboard. Setting this option causes the clipboard contents to wrap when all channels have been pasted so that all channels in
the target sample will have data pasted to them.

Unknown filetypes
SampleEd is able to load a wide range of formats. These are initially identified by filetype but if this fails they will be identified
by file content. Some formats will however remain unrecognized. SampleEd will still load these files but must be told what format
they are. This section allows the defaults for this identification to be set.

Sample rate
This is the frequency of the sample. The number specified is in Hertz. 41666 Hertz is the same quality as a Compact Disc.
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Channels
The number of channels that the sample will have. This can be any number from 1 to 32 but the most common settings will be
1 for mono or 2 for stereo.

Format
This is encoding that SampleEd will assume is applied to the imported file. Available formats are ass follows:

Unsigned 8 bit PCM
Signed 8 bit PCM
Signed 16 bit PCM
Signed 24 bit PCM
Signed 32 bit PCM
32 bit float
64 bit float
U-Law
A-Law
GSM 6.10
12 bit DWVW
16 bit DWVW
24 bit DWVW
VOX ADPCM
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New file details
This section allows the defaults used when a new sample is created to be set.

Sample rate
This is the frequency of the sample. The number specified is in Hertz. 44100 Hertz is the same quality as a Compact Disc. The
higher the frequency the better quality the sound will be but the more memory it will use.

Channels
The number of channels that the sample will have. This can be any number from 1 to 32 but the most common settings will be
1 for mono or 2 for stereo. The size of the sample will increase in proportion to the number of channels chosen.

The Drivers button will open the Installed drivers window which allows the drivers that are installed to be removed or new drivers
added. This is covered in the next section.

Loading
Claim known sound files
When this is ticked, double clicking on a file with a type that SampleEd has a driver for will cause it to be loaded. If not ticked
then the file will have to be dragged to SampleEd.

Play either side of highlighted sample
Time
This allows the amount of time, specified in centiseconds, to be set when playing around the highlighted sample area.

Once the choices have been set click OK to save them or Cancel to close the window without saving them.
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Installed drivers
Clicking the Drivers button in the Choices window will display the Installed drivers window:

This window allows the installed drivers the are used to load and save different types of files in SampleEd to be removed or new
drivers added. The list displays the following information:

Name
The name of the driver.

Version
The version number of the driver. Some drivers make use of third party libraries. If a version number appears in brackets it refers
to the version of the third party library the driver uses.

Filetypes
A list of different types of file that the driver can load and possibly save. Each type might include several sub types which will
not be listed.
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Installing new drivers
New drivers are installed by dragging a driver directory to the Installed drivers window:

The new driver will then appear in the window:
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Removing drivers
A driver is removed by highlighting it in the list and clicking on Delete:

A confirmation prompt will appear and clicking OK will remove the driver. Note that this operation cannot be undone, unless the
driver is reinstalled, so you should be sure you want to remove the driver before taking this action.
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The main menu
The main menu is displayed by clicking Menu over a window:

The following options are available:

File
Moving the pointer over this item shows the File menu:
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Info
Displays information about the sample including when it was last modified, the name and size:

Save
Displays a save dialog box. The sample can be saved by dragging the icon to a filer window or entering a name and clicking
Save:
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The dialog box displayed is not the standard save dialog box, there are three extra fields.

The first two of these allow the format of the sample being saved to be specified. For a full list of sample formats refer to
Appendix A.

The third field controls the way samples with more than one channel are saved. It has the following choices:

All channels
If this chosen then all of the channels are saved independently within the file (format permitting).

Mono
Choosing this will downmix all of the channels to produce a single channel sample. The channel volume settings are honoured
when the channels are downmixed.

Stereo
When chosen this will downmix the channels to produce a stereo sample. The channel volume and stereo settings are
honoured when the channels are downmixed.

Selection
If this is switched on then only the currently highlighted section of the sample will be saved. If no area of the sample is
highlighted then this will be greyed out.

New view...
Choosing this item displays another window containing the same fade. This can be useful when copying or moving pictures
from one section of a large sequence to another.
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Edit
Moving the pointer over this item shows the Edit menu.:

This is covered in detail in the section entitled Editing a sample.
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Effect
Moving the pointer over this item shows the Effect menu:

This is covered in detail in the section entitled Applying effects to samples.

Utilities
Moving the pointer over this item shows the Utilities menu:

This has a single entry which allows the magnification factor of the displayed sample to be set. This will have no effect on the
underlying sample, only the way it is displayed.
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Scale
Moving the pointer over the Scale view entry or pressing F11 will display the Scale dialog:

Scale
This is the percentage at which the sample will be displayed. 100% is the normal size.

33%, 80% ,100%, 120%
These buttons provide predefined scale factors as marked.

Scale to fit
Clicking this button will try to scale the sample to best fit on the screen.

Horizontal
If this is ticked the scaling will apply horizontally to the sample.

Vertical
If this is ticked the scaling will apply vertically to the sample.

Once the percentage has been set click Scale to scale the display or Cancel to close the window without making any changes.
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Help
This item will display the help supplied with the application.
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The iconbar menu
Clicking Menu over the Fade icon on the iconbar will display this menu:

The following items are available:

Info
Moving the mouse pointer over this item displays the About this program window which displays version information about
SampleEd.

Help
This item will display the help supplied with the application.
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Choices...
Displays the Choices window which allows preferences for the application to be set. This is covered in detail elsewhere.

Rescan
This displays two further items:

Drivers
This will cause the drivers used to load and save different file formats to be rescanned in case any have been added.

Plugins
This performs the same operation for plugins in case any have been added.

Quit
Choosing this item will cause SampleEd to exit.
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Appendix A
The sample formats that SampleEd can load and save are governed by what drivers are installed in the SampleEd application.
The following basic and sub formats are supported by default. Not all sub formats for each basic format are supported. In
particular, Wave files have tens of sub formats of which only a handful are supported.

Format Sub format Description Import Export Notes
AIFF Unsigned 8 bit PCM Apple/SGI ✔ ✔ Support provided by libsndfile

Signed 8 bit PCM ✔ ✔
Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
GSM 6.10 ✔ ✔
12 bit DWVW ✔ ✔
16 bit DWVW ✔ ✔
24 bit DWVW ✔ ✔

AU Signed 8 bit PCM Sun/NeXT ✔ ✔ Support provided by libsndfile
 Signed 16 bit PCM ✔ ✔
 Signed 24 bit PCM ✔ ✔

Signed 32 bit PCM ✔ ✔
 32 bit float ✔ ✔
 64 bit float ✔ ✔
 U-Law ✔ ✔
 A-Law ✔ ✔
 32kbs G721 ADPCM ✔ ✔

24kbs G723 ADPCM ✔ ✔
40kbs G723 ADPCM ✔ ✔
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Format Sub format Description Import Export Notes
AVR AVR Audio Visual Research ✔ ✔ Support provided by libsndfile

Armadeus Armadeus Armadeus ✔ ✔

CDTrack CDTrack AudioFS ✔ ✔ Support provided by libsndfile

HTK Signed 16 bit PCM HMM Tool Kit ✔ ✔ Support provided by libsndfile

IFF Signed 8 bit PCM Amiga IFF/SVX8/SV16 ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔

MAT4 Signed 16 bit PCM GNU Octave/Matlab 4.2 ✔ ✔ Support provided by libsndfile
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔

MAT5 Unsigned 8 bit PCM GNU Octvae 2.1/ ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM Matlab 5.0 ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔

MP3 MPEG MP3 layer I, II and III ✔ ✔ Support by provided by LAME

PAF Signed 8 bit PCM Ensoniq PARIS ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔

PVF Signed 8 bit PCM Portable Voice Format ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔
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Format Sub format Description Import Export Notes
RAW Unsigned 8 bit PCM Header less data ✔ ✔ Support provided by libsndfile

Signed 8 bit PCM ✔ ✔
Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
GSM 6.10 ✔ ✔
12 bit DWVW ✔ ✔
16 bit DWVW ✔ ✔
24 bit DWVW ✔ ✔
VOX ADPCM ✔ ✔

SDS SDS MIDI Sample Dump ✔ ✔ Support provided by libsndfile

SF Signed 16 bit PCM Berkeley/IRCAM/CARL ✔ ✔ Support provided by libsndfile
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔

VOC Unsigned 8 bit PCM Creative Labs ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
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Format Sub format Description Import Export Notes
W64 Unsigned 8 bit PCM SoundFoundry WAVE 64 ✔ ✔ Support provided by libsndfile

Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
GSM 6.10 ✔ ✔
IMA ADPCM ✔ ✔
Microsoft ADPCM ✔ ✔

WAV Unsigned 8 bit PCM Microsoft Wave ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔ and LAME
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
32 bit float ✔ ✔
64 bit float ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
GSM 6.10 ✔ ✔
IMA ADPCM ✔ ✔
Microsoft ADPCM ✔ ✔

WAV Signed 8 bit PCM NIST Sphere ✔ ✔ Support provided by libsndfile
Signed 16 bit PCM ✔ ✔
Signed 24 bit PCM ✔ ✔
Signed 32 bit PCM ✔ ✔
U-Law ✔ ✔
A-Law ✔ ✔
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Format Sub format Description Import Export Notes
XI 8 bit DPCM FastTracker 2 ✔ ✔ Support provided by libsndfile

16 bit DPCM ✔ ✔
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Appendix B
This appendix lists all the functions and constants that can be included in an equation. Note that this information is taken from
the documentation that comes with the ExprEval library.

Functions

    Function Min. Args Max. Args Result/Comment

    abs(v) 1 1 Absolute value of v.
abs(-4.3) returns 4.3

    mod(v,d) 2 2 Remainder of v/d.
mod(5.2,2.5) return 0.2

    ipart(v) 1 1 The integer part of v.
    ipart(3.2) returns 3

    fpart(v) 1 1 The fractional part of v.
    fpart(3.2) returns 0.2

    min(v,...) 1 None The minimum number passed.
    min(3,2,-5,-2,7) returns -5

    max(v,...) 1 None The maximum number passed.
    max(3,2,-5,-2,7) returns 7

    pow(a,b) 2 2 The value a raised to the power b.
    pow(3.2,1.7) returns 3.2^1.7

    sqrt(a) 1 1 The square root of a.
    sqrt(16) returns 4
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Function Min. Args Max. Args Result/Comment

sin(a) 1 1 The sine of a radians.
    sin(1.5) returns around 0.997

sinh(a) 1 1 The hyperbolic sine of a.
    sinh(1.5) returns around 2.129

 asin(a) 1 1 The arc-sine of a in radians.
    asin(0.5) returns around 0.524

cos(a) 1 1 The cosine of a radians.
    cos(1.5) returns around 0.0707

cosh(a) 1 1 The hyperbolic cosine of a.
    cosh(1.5) returns around 2.352

acos(a) 1 1 The arc-cosine of a in radians.
    acos(0.5) returns around 1.047

tan(a) 1 1 The tangent of a radians.
    tan(1.5) returns around 14.101

tanh(a) 1 1 The hyperbolic tangent of a.
    tanh(1.5) returns around 0.905

atan(a) 1 1 The arc-tangent of a in radians.
    atan(0.3) returns about 0.291

atan2(y,x) 2 2 The arc-tangent of y/x, with quadrant correction.
    atan2(4,3) returns about 0.927
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Function Min. Args Max. Args Result/Comment

log(a) 1 1 The base 10 logarithm of a.
    log(100) returns 2

pow10(a) 1 1 10 raised to the power of a.
    pow10(2) returns 100

ln(a) 1 1 The base e logarithm of a.
    ln(2.8) returns around 1.030

exp(a) 1 1 e raised to the power of a.
    exp(2) returns around 7.389

logn(a,b) 2 2 The base b logarithm of a.
    logn(16,2) returns 4

ceil(a) 1 1 Rounds a up to the nearest integer.
    ceil(3.2) returns 4

floor(a) 1 1 Rounds a down to the nearest integer.
    floor(3.2) returns 3

rand() 0 0 Returns a number between 0 up to but not
    including 1.

random(a,b) 2 2 Returns a number between a up to and
    including b.

srand(a) 1 1 Seeds the random number generator with a value.
    Return value is unknown
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Function Min. Args Max. Args Result/Comment

randomize() 0 0 Seed the random number generator with a value based on the current time.
Return value is unknown

deg(a) 1 1 Returns a radians converted to degrees.
    deg(3.14) returns around 179.909

rad(a) 1 1 Returns a degrees converted to radians.
    rad(180) returns around 3.142

recttopolr(x,y) 2 2 Returns the polar radius of the rectangular co-ordinates.
recttopolr(2,3) returns around 3.606

recttopola(x,y) 2 2 Returns the polar angle (0...2PI) in radians of the rectangular co-ordinates.
    recttopola(2,3) returns around 0.588

poltorectx(r,a) 2 2 Returns the x rectangular co-ordinate of the polar co-ordinates.
    poltorectx(3,1.5) returns around 0.212

poltorecty(r,a) 2 2 Returns the y rectangular co-ordinate of the polar co-ordinates.
    poltorecty(3,1.5) returns around 2.992

if(c,t,f) 3 3 Evaluates and returns t if c is not 0.0. Else evaluates and returns f.
    if(0.1,2.1,3.9) returns 2.1

select(c,n,z[,p]) 3 4 Returns n if c is less than 0.0.
    Returns z if c is 0.0. If c is greater than 0.0 and only three arguments were

passed, returns z. If c is greater than 0.0 and four arguments were passed, 
return p.

    select(3,1,4,5) returns 5
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Function Min. Args Max. Args Result/Comment

equal(a,b) 2 2 Returns 1.0 if a is equal to b. Else returns 0.0
    equal(3,2) returns 0.0

above(a,b) 2 2 Returns 1.0 if a is above b. Else returns 0.0
    above(3,2) returns 1.0

below(a,b) 2 2 Returns 1.0 if a is below b. Else returns 0.0
    below(3,2) returns 0.0

avg(a,...) 1 None Returns the average of the values passed.
    avg(3,3,6) returns 4

clip(v,min,max) 3 3 Clips v to the range from min to max.
    If v is less than min, it returns min. If v is greater than max it returns max. 

Otherwise it returns v.
    clip(3,1,2) returns 2

clamp(v,min,max) 3 3 Clamps v to the range from min to max, looping if needed.
    clamp(8.2,1.3,4.7) returns 1.4

pntchange(side1old, 5 5 This is used to translate points from different scale.
    side2old, Works no matter the orientation as long as the sides are lined up correctly.
    side1new,     pntchange(-1,1,0,480,-0.5) returns 120 (x example)
    side2new, pntchange(-1,1,480,0,-0.5) returns 360 (y example)
    oldpnt)
    
poly(x,c1,...) 2 None This function calculates the polynomial. x is the value to use in the 

polynomial. c1 and on are the coefficients.
    poly(4,6,9,3,1,4) returns 2168
    same as 6*4^4 + 9*4^3 + 3*4^2 + 1*4^1 + 4*4^0
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Function Min. Args Max. Args Result/Comment

and(a,b) 2 2 Returns 0.0 if either a or b are 0.0 Else returns 1.0
    and(2.1,0.0) returns 0.0

or(a,b) 2 2 Returns 0.0 if both a and b are 0.0 Else returns 1.0
    or(2.1,0.0) returns 1.0

not(a) 1 1 Returns 1.0 if a is 0.0 Else returns 0.0
    not(0.3) returns 0.0

for(init,test,inc,a1,...) 4 None This function acts like a for loop in C. First init is evaluated. Then test is 
evaluated. As long as the test is not 0.0, the action statements (a1 to an) 
are evaluated, the inc statement is evaluated, and the test is evaluated 
again. The result is the result of the final action statement.

    for(x=0,below(x,11),x=x+1,y=y+x) returns 55.0 (if y was initially 0.0)

many(expr,...) 1 None This function treats many subexpressions as a single object (function). It is
mainly for the ‘for’ function.

    for(many(j=5,k=1),above(j*k,0.001),many(j=j+5,k=k/2),0)
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Constants

Constant Math Form Value

M_E e 2.7182818284590452354
M_LOG2E log_2 (e) 1.4426950408889634074
M_LOG10E log_10 (e) 0.43429448190325182765
M_LN2 ln(2) 0.69314718055994530942
M_LN10 ln(10) 2.30258509299404568402
M_PI 

�

3.14159265358979323846
M_PI_2 

��

2 1.57079632679489661923
M_PI_4 

�

/4 0.78539816339744830962
M_1_PI 1/

�

 0.31830988618379067154
M_2_PI 2/

�

0.63661977236758134308
M_1_SQRTPI 1/

�� �

) 0.56418958354776
M_2_SQRTPI 2/

�� �

) 1.12837916709551257390
M_SQRT2 

�

?(2) 1.41421356237309504880
M_1_SQRT2 1/

�

?(2) 0.70710678118654752440
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Project Address  and functionality
libsndfile http://www.mega-nerd.com/libsndfile

Loading and saving of a large number of sample formats

LAME http://cerberus.archifisal.co,uk/software/riscos/lame.html
Decoding and encoding of MP3 files

LADSPA http://www.ladspa.org
Plugin protocol specification and sample implementation

Digital Renderer http://www.zarquon.homepage.t-online.de/Software.html#drender
Sample playback

expreval http://www.codeproject.com/library/expreval.asp
Expression evaluation
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